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Preface

Students can now study the basic scientific principles on the same world-class equipment used by
leading researchers in the university and government labs and more excitingly, NASA. With
advances in electro-optics and their continuous impact on the sensing community, high-speed
array detectors, inexpensive optical fibers and powerful computers have made optical
spectroscopy the sensing technique of choice for many real-world applications.

The development and marketing of scientific instruments and methods have changed in an
equally dramatic way; in the past, cutting-edge instrumentation started with expensive research
devices that were accessible only to well-funded research and development enterprises, gradually,
the technologies filtered into general laboratory use, application-specific instruments and now
into the educational settings.

Our knowledge of spectroscopy has been based upon years of experimentation in a wide array of
disciplines ranging from art to applied physics. All of the fields have strong roots in education,
more specifically teaching and learning the basics of the field. It has been the experience of
thousands of science educators that have utilized the Ocean Optics spectrometers with there own
specific real world exciting experiments that the students in there classes lives have been enriched
and have a greater appreciation for science.

It is important that today's science and engineering students appreciate the capabilities of optical
sensing, the fundamental physics of the measurement process, the design trade-offs inherent in
selecting and integrating components, and the discipline required to produce quality results. The
goal of this lab manual is to provide a vehicle to allow future scientist to study the fundamentals
of spectroscopy using modern research/industry instrumentation.

I would like to offer special thanks to the educators who contributed to this lab manual as part of
the ongoing Ocean Optics grant program.

Note to Educators: If you would like to contribute to future compilations, please send an email to
education@oceanoptics.com.

Copyright © 2007 Ocean Optics, Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, by any means,
clectronic, mechanical, photocopying, recording, or otherwise, without written permission from Ocean Optics, Inc.

This manual is sold as part of an order and subject to the condition that it shall not, by way of trade or otherwise, be lent, resold, hired
out or otherwise circulated without the prior consent of Ocean Optics, Inc. in any form of binding or cover other than that in which it
is published.

Trademarks

All products and services herein are the trademarks, service marks, registered trademarks or registered service marks of their
respective owners.

Limit of Liability

Ocean Optics has made every effort to ensure that this manual as complete and as accurate as possible, but no warranty or fitness is
implied. The information provided is on an “as is” basis. Ocean Optics, Inc. shall have neither liability nor responsibility to any person
or entity with respect to any loss or damages arising from the information contained in this manual.
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1 Beer’s Law of Potassium
Permanganate

The Spectrometer and Beer’s Law

The direct relationship between absorbance and concentration for a solution is known as the Beer-
Lambert Law, or more commonly Beer’s law. You can use Beer’s law to test several samples of a
solution, of known molar concentrations, and calculate a best-fit line equation to relate the
absorbances of the solutions to their concentrations.

The primary objective of this experiment is to determine the concentration of an unknown
potassium permanganate, KMnQy, solution. You will first use a spectrometer to measure the
absorbance of one KMnOj, solution over the visible light spectrum and select the wavelength of
maximum absorbance. You will prepare five potassium permanganate solutions of known
concentration, which are your standard solutions. You will to measure the concentration of each
standard solution to establish the Beer’s law best-fit line equation for the KMnO, standards.

You will use the best-fit line function for the standard solutions to determine the molar
concentration of a KMnOQ, solution of unknown concentration.

Materials
0 Ocean Optics Spectrometer O 2.00 x 10~ M potassium permanganate,
O computer KMnOy,, solution
O several cuvettes o KMnO, solution, unknown concentration
o 1 dark cuvette o distilled water
O 6 test tubes and test tube rack o small beakers
0 10 mL graduated cylinders or pipettes o plastic Beral pipettes

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

© 2007 Ocean Optics, Inc 3
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Procedure
1. Label five test tubes to use for your standard solutions. Prepare the KMnQOj, standards according
to the chart below.
Test Tube [KMnO4] mL of 2.00 x 10-* M KMnO4 (aq) | mL of distilled water
(mollL)
1 4.00x 10" |20 8.0
2 8.00x 107" | 4.0 6.0
3 1.20x10° | 6.0 4.0
4 1.60 x 10° | 8.0 2.0
5 2.00x10° | 10.0 0.0

2. Obtain a small amount of KMnO4 solution of unknown concentration. Set it aside to test after
you have measured the absorbances of the standard solutions.

3. Fill a cuvette ~% full with distilled water to serve as your blank.

4. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

5. Calibrate the spectrometer.

a.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to
warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New —
Absorbance Measurement. The “Set Acquisition Parameters wizard” will appear. This
process has four steps. First, confirm that your spectrometer has been identified, and
then click _> |

In step two of this process, make sure that the box next to “Strobe/Lamp Enable” is
checked. Manually select a suitable integration time by using the arrow keys to increase
or decrease the integration time, in milliseconds. Click _Met> g0 proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the Store
Reference Spectrum icon, « . Click _et> |t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save the
dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.

Pour out the distilled water from the blank cuvette, rinse, and fill it with the 4.00 x 107
M KMnO; solution in Test Tube #1. Place the cuvette in the spectrometer. Click
L_fsh | to complete the acquisition parameters wizard.

© 2007 Ocean Optics, Inc
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g. A plot of absorbance vs. wavelength for your KMnO, solution is displayed.

6. Examine the graph and select the peak wavelength that you wish to use for your Beer’s law
experiment.

7. Set up the Beer’s law experiment.

a.  Open the File menu and choose New — New Concentration Measurement. Select

“Active Processing:”, and then click |fe=st )

b. The Concentration Measurement Setup wizard appears, and its default is the Beer-
Lambert Law. Select “Calibrate from solutions of known concentration”. Click _"> |

¢. The Range Selection defaults to a single wavelength. Enter the peak wavelength that
you identified in Step 6, and then click _Mext> |

d. The next dialog box sets up the Beer’s law graph of your standard solutions. Type in
the molar concentratlon of your first sample, 0.0004. Click |L| and then click
__##dsade | The absorbance of your first standard is saved and plotted on the small
graph in the dialog box.

e. Remove the cuvette and dispose of the solution as directed. Rinse and fill the cuvette
with the KMnO#4 standard solution in Test Tube #2. Place the cuvette in the

spectrometer Type in the molar concentration, click |&| and then click
Add Sampls |

f.  Repeat step e for the remaining standards. When you complete the final standard
solution (2.00 x 10-3 M), type in the compound name and unit of concentration
(mol/L). A best-fit line is calculated for your standards. Make sure the regression order

is set to 1 Note To delete a data point, choose a row of data and click .

8. To measure the absorbance of the KMnO4 solution of unknown concentration, rinse and fill the
cuvette ~% full with the unknown sample. Click Single Update and write down the
concentration of your unknown.

9. To close the SpectraSuite program, select File — Exit, and then click (e ],

© 2007 Ocean Optics, Inc 5
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Data Table

Concentration

(mol/L) Absorbance

Test Tube

Unknown #

Data Analysis

1.

The graph of absorbance vs. wavelength for the KMnO4 solution shows two peaks that are
fairly close together. Which wavelength did you measure the absorbance of the KMnO4
standard solutions? Explain.

Does the temperature of the solutions matter when conducting a Beer’s Law experiment?
Explain why or why not.

A student prepares the KMnO4 standard solutions and reads the volume incorrectly and low.
For example, the student reads the volume as 10 mL when it is actually 11 mL. Explain how this
error will affect the determination of a KMnO4 solution of unknown concentration?

© 2007 Ocean Optics, Inc
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2 Introduction to Reaction Rates

Introduction

An important piece of information one can learn about a chemical reaction is the reaction rate.
While it is a huge oversimplification to think of reaction rate as the amount of time it takes for the
products to be formed in a chemical reaction, it sometimes boils down to that very fact.

In this experiment, you will conduct a simple reaction between to household products: food
coloring and bleach. The sodium hypochlorite in the bleach will react with the food coloring to
form a nearly colorless product. A generic reaction equation is shown below:

bleach + food dye — products

In this experiment, it will not be important to identify the exact molecular species that participate
in the reaction. It is, however, important to record the change of the color of the reaction as it
proceeds. This will be the job of the spectrometer.

The study of reaction rates is called chemical kinetics. When chemical kinetics is studied, it is
common to limit the investigation of a reaction to one or two easily controlled variables. In this
experiment, you will determine the effect of concentration on the reaction rate. To test the effect
of the concentration of the food coloring, you merely have to measure the fading color over time.
By selecting the proper wavelength, or wavelengths, the spectrometer will measure this for you.
To test the effect of the concentration of bleach, you will have to conduct the reaction at least
twice and change the initial bleach concentration. By measuring how the change in bleach
concentration affects the time needed for the food color to fade, you can determine bleach’s
impact on the rate of the reaction.

Establishing the effect of concentration on reaction rate is called rate order. The goal of your
data analysis will be to determine the order of the reaction with respect to the two reactants,
bleach and food coloring.

Objectives

In this experiment, you will

=  Measure the visible light absorbance spectrum of a food coloring solution to identify the
wavelength of maximum absorbance (A max).

=  Measure the absorbance of the reaction between a food coloring solution and bleach at
the A max over a given length of time.

= Use your test results to determine the order of the reaction with respect to bleach and
food coloring.

Materials
O Ocean Optics Spectrometer a Food coloring

© 2007 Ocean Optics, Inc 7
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Household chlorine bleach

0.70 M sodium hypochlorite, NaOCl
0.70 M sodium chloride, NaCl, solution
Distilled water

Plastic Beral pipettes

Computer

1 cuvette

1 dark cuvette

50 mL and 150 mL beakers

O 10 mL and 25 mL graduated cylinders

UO00D
0O000D

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure

1.

Prepare your food coloring solution by adding 2 drops of food coloring to 50 mL of distilled
water. Obtain about 10 mL each of 0.70 M NaCl solution and bleach (0.70 M NaOCl solution).

Part I: Set up the Spectrometer

2.

3.

10.

11.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to warm
up for at least five minutes before proceeding. If desired, skip ahead to Part II to prep your
solutions for the first trial.

Fill a cuvette ~%4 full with distilled water to serve as a blank.

Place the blank cuvette in the spectrometer. On the left hand side of the toolbar, manually
increase or decrease the integration time so that the peak absorbance is slightly below 4,000
counts.

Record the absorbance spectrum of the blank (100% transmittance), by clicking the Store
Reference Spectrum icon, « (the yellow light bulb just above the graph).

Remove the blank cuvette and place the dark cuvette in the spectrometer. Save the dark
reference (0% transmittance), by clicking the Store Dark Spectrum icon, ¥ (the gray light bulb
above the graph).

Remove the dark cuvette from the spectrometer. Empty the distilled water from the blank
cuvette, rinse and fill the cuvette ~%; full of the food coloring solution, and place the cuvette in
the spectrometer. Identify the wavelength of maximum absorbance (A max) for your food

coloring solution and write it down. This is the wavelength you will use as you measure the
absorbance of the reaction.

Click the Absorbance mode icon, A.
Open the File menu and select New — Strip Chart.

In the Chart Trend Settings dialog box, check the box next to Stop after this amount of time and
change the time to 3 minutes.

© 2007 Ocean Optics, Inc
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12. On the right side of the dialog box under Range Selection select One Wavelength and select
the A max for your food coloring solution.

Part Il: Conduct the First Reaction (Trial One)

13. Measure and transfer 18 mL of the food coloring solution and 1 mL of the NaCl solution to a
clean and dry 50 mL beaker.

14. Pour out the food coloring from the cuvette and rinse the cuvette with small amounts of distilled
water.

15. Measure and transfer 1 mL of bleach to the 50 mL beaker of food coloring solution. Swirl the

beaker to mix the solutions. Use a plastic Beral pipette to rinse and fill the cuvette ~% full of the
reaction solution from the 50 mL beaker. Place the cuvette in the spectrometer.

16. Click 2% ] A graph of absorbance vs. time will be displayed. If the Strip Chart Options
dialog box appears, use your mouse to move it aside during the data collection.

17. After the run ends, export the emission measurements to Microsoft Excel.

a. Click the Copy Spectral Data to Clipboard icon, == ,0n the toolbar.
b. Open Microsoft Excel.

c. In Excel, open the Edit menu and choose Office Clipboard...

d. Click the spectral data file on the clipboard.

18. To store your data, click Save, ® . In the Save Trend dialog box, highlight the trend and click

the Browse button, L==%= | Choose a location for the file, name it, and then click the Save
button, _*=_J, Back on the Save Trend dialog box, click |_===_J. Click L= | to continue.

Part lll: Conduct the Second Reaction (Trial Two)

In Trial Two, you will increase the amount of bleach to measure its effect on the reaction rate.
19. Measure and transfer 18 mL of the food coloring solution to a new clean and dry 50 mL beaker.

20. Pour out the reaction mixture from the cuvette and rinse the cuvette with small amounts of
distilled water.

21. As before, open the File menu and select New — Strip Chart. In the Chart Trend Settings dialog
box, check the box next to Stop after this amount of time and change the time to 3 minutes.
Under Range Selection select One Wavelength and select the A max for your food coloring
solution.

22. Measure and transfer 2 mL of bleach to the 50 mL beaker of food coloring solution. Swirl the
beaker to mix the solutions. Use a plastic Beral pippette to rinse and fill the cuvette ~%; full of
the reaction solution from the 50 mL beaker. Place the cuvette in the spectrometer.

© 2007 Ocean Optics, Inc 9
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23. Click % ] If the Strip Chart Options dialog box appears, use your mouse to move it aside
during the data collection.

24. Repeat Steps 17 and 18 to manage the data from Trial Two.
25. To close the SpectraSuite program, select File — Exit, and then click Lres ]

26. Dispose of the solutions as directed by your instructor.

Data Analysis, Trial One

1. Prepare three plots: absorbance vs. time, In abs vs. time, and 1/abs vs. time. Calculate the best-
fit line equation for the plot that is the most linear, and write down the equation.

2. The order with respect to the food coloring can be determined by graphically applying the
integrated rate laws. According to Beer’s law, the absorbance of a food coloring solution is
directly proportional to its concentration. Thus, the actual [food coloring] can be replaced by
Amax, the maximum absorbance of the food coloring solution. A graph of Amax as a function
of time will give a straight line if the reaction is zero order in food coloring. If the reaction is
first order, then a graph of In(Amax) as a function of time is linear. Finally, for the purposes of
this experiment, if the reaction is second order, then a graph of 1/Amax as a function of time is
linear. Based on the equation you selected to answer #1, what is the order of the reaction with
respect to the food coloring — zero, first, or second order?

Data Analysis, Trial Two

3. Examine the graph of absorbance vs. time for both Trials One and Two. Select a brief period of
time, 20-30 seconds, within the first minute of each trial and calculate the best fit line equation
for Trials One and Two. Write down these two equations.

4. Because bleach does not change color in this reaction, you must analyze the initial rates of the
reaction to determine the order with respect to bleach. In this instance, as with many others,
during the first few moments the reaction proceeds as if it was zero order overall. Thus, the
slopes of the best-fit line equations you calculated in #3 are also the reaction rates of Trials One
and Two. Compare the slopes of Trials One and Two. If they are essentially the same, then the
order of the reaction with respect to bleach is zero. If the slope of Trial Two is about twice the
slope of Trial One, then the reaction is first order in bleach because doubling the bleach
concentration caused the reaction to double. If the slope of Trial Two is closer to four times that
of Trial One, then the reaction is second order in bleach.

5. Consult your textbook, if needed, to learn about rate laws. Write the rate law for this reaction.
6. Household bleach is 5.25% NaOCI (mass/volume). The qualitative (not perfectly accurate)

concentration of food coloring is 0.0020 M. Use this information to calculate the value of the
rate law constant, k.

One Final Question

7. Why was the NaCl solution included in this experiment?

10 © 2007 Ocean Optics, Inc
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3 Investigating the Atomic Spectrum of
Hydrogen

Introduction

Hydrogen, with it lone electron, possess the simplest of all atomic spectra. When energy is
applied to a hydrogen atom, the electron can be moved (an excited state) to a higher energy state
but it doesn’t remain in the higher energy state. When the electron returns to its original
“position”, a photon of light is released. The energy of this emitted photon is equal to the
difference in energies of the two states. The Rydberg equation describes this situation
mathematically:

2 %

AE = ---th”-[ L—i J =hcv', m=123..., ne=m+1, ;+2, m;+3. ...
n, n;,

The variable v' represents the wave number of the emitted photon. The speed of light, c, is

measured in cm/s. When nl = 1, the transitions occur in the ultraviolet light region, known as the

Lyman series. When nl = 2, the transitions occur in the visible light region, known as the Balmer

series. Other values of nl result in series that occur in the infrared light region.

In this experiment, we will focus our attention on the Balmer series of hydrogen — the visible
light region. You will energize hydrogen gas that is contained in a sealed discharge tube (a
specially designed light bulb, in essence). When you “turn on” the hydrogen discharge tube, you
will see a colored light. The naked eye can see the Balmer series but what you see is a
conglomeration of all the emitted photons. You will use an Ocean Optics spectrometer to not only
measure the emitted photons but distinguish between them as individual lines at specific
wavelengths in the visible region of light, ~400 nm - ~700 nm.

Mathematically, determining the wavelengths of light produced by the photons emitted in the
Balmer follows the form shown below:

. hm’*
im ‘on’ '
The variable m and n are integers, and h =3654.6 x 10-8 cm. When you solve the equation with
n=2and m =3, 4, 5, or 6, the calculated wavelengths represent the four emission lines in the

Balmer series for hydrogen. These four wavelengths produce the color that your eyes can see in
the energized hydrogen discharge tube.

In this experiment you will measure the emission spectrum of hydrogen gas and analyze the
emission data to conduct important calculations describing the element hydrogen.

Objectives

In this experiment, you will

= Measure the visible light emission spectrum of a hydrogen in a discharge tube.

=  Analyze the hydrogen emission spectrum to identify the Balmer series.

12 © 2007 Ocean Optics, Inc
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=  Analyze the Balmer series data to determine the Rydberg constant and the first ionization

energy of hydrogen.
Materials
0 Ocean Optics Spectrometer 0 fiber optic accessory
Q computer 0 hydrogen gas discharge tube
Procedure

1. Use a USB cable to connect an Ocean Optics or a Vernier Spectrometer to your computer. Make
sure that the light source/cuvette holder has been detached from the spectrometer. Connect a
fiber optic cable to the threaded detector housing of the spectrometer.

2. Start the SpectraSuite software.
3. Turn on the hydrogen gas discharge tube. Aim the tip of the fiber optic cable at the tube.

4. There are two methods of optimizing the graph of intensity vs. wavelength. Use the method that
produces a better graph of the emission lines.

a. Set the distance between the light source and the tip of the fiber optic cable so that the
peak intensity on the graph is ~3500 counts.

b. Adjust the Integration Time, which is located in the upper left hand portion of the
SpectraSuite window. If the peak absorbance is off scale, reduce the integration time. If
the peaks are too small, increase the integration time.

5. When you are satisfied with your emissions graph, click Save, & In the Save Spectrum
dialog box, click the Browse button, L&==-_|. Choose a location for the file, name it, and then
click the Save button, L_*==_J. Back on the Save Spectrum dialog box, click L_===_J. Click

L= | {0 continue.

6. To view the emission spectrum graph:

a. Click the Overlay Spectral Data icon, g, on the right of the toolbar.
b. Choose the file you saved in Step 5, and then click the Open icon, [ |,

c. Inthe Load Spectrum dialog box, choose your file (which will be coded as
“Processed”), and then click the Load icon, | == |,

7. To analyze your emission spectrum graph:

a. Click anywhere on the graph to activate the cursor. Note the green vertical line marking
a given wavelength on the graph; a box below the graph identifies the wavelength.

b. Identify the four emission lines for hydrogen and write then down in the data table.

8. To close SpectraSuite, select File — Exit, and then click [res ]

© 2007 Ocean Optics, Inc 13
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Data Table

Complete the table below. You will have already recorded the wavelengths from examining the
graph of the hydrogen discharge tube emissions.

To calculate the wavenumber, frequency, and photon energy:

=  Wavenumber = 10° / (wavelength in nm)

=  Frequency = (3 x 10® m/s) / (wavelength inm) Note: I nm=1 x 10° m

=  Photon Energy = (frequency) x A Note: 7= 6.626 x 10°* m*kg's™
Wavelength (nm) | Wavenumber (m-') | Frequency (Hz) Photon Energy (J) | ni(Balmer Series)

3

4

5

6

Data Analysis

1. Use the equation described in the introductory remarks to calculate the Rydberg constant for the
four lines in Balmer Series. For the Balmer series, n = 2. What is the average value for the
Rydberg constant, based on your data.

2. Another equation is often used to analysis photon emitted from energized hydrogen.

[P A
A n; n;

R, is a constant called the Rydberg constant. It is an important part of the study of hydrogen.
Calculate R, for each of the four Balmer lines. In each case, n,= 2, and n; will be 3, 4, 5, or 6.
What is the average value of R,,?

3. An accepted value of the Rydberg constant, Rm, is 1.097 x 107 m—1. Compare your value of
Rm to the accepted value.

4. Use the Rm that you calculated in #2 to predict the wavelength of the fifth line in the Balmer
Series (n = 7). Examine your graph of the hydrogen discharge tube emissions. Does the fifth

Balmer line appear in your graph? Explain.

5. Use the data in your table to calculate the first ionization energy of hydrogen, in kJ/mol.
Compare your calculated value with the accepted value of 1312.0 kJ/mol.

14 © 2007 Ocean Optics, Inc
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4 The Determination of the pKa of an
Indicator Solution

Introduction

Generally speaking an indicator can be considered a weak acid. Its value as a visual indicator
stems from the equilibrium it establishes and the different colors the indicator presents as its
equilibrium is shifted. You will make use of this property of indicators to collect sufficient
spectrophotometric measurements on your way to confirming the pKa of bromcresol green.

Historically, the pKa was found by preparing buffers of various values within the color transition
range and calculating the pKa from the Henderson-Hasselbach equation. The chemical behavior
of a buffer, HIn, can be expressed as shown below.

Hin o In +H
Because the absorbance of a solution at a given wavelength varies directly with concentration
(Beer’s Law), one can determine the pKa of an indicator by carefully measuring the absorbances
of five solutions: 1.0 M HCI, 1.0 M NaOH, and three buffirs of specific pH values. The data

Iogk + —&

analysis will allow you to prepare a plot of pH vs. o A The value of k can be calculated
by taking and absorbance readings at AIn max after the equilibrium has been shifted, for all
practical purposes, to the right by the addition of NaOH, and AHIn max after the equilibrium has
been nearly 100% to the left by the addition of HCI.

Objectives

The objectives of this experiment are:

= Measure the absorbance spectrum of a series of five solutions of varying pH that contain
the indicator bromcresol green.

= Determine the absorbance readings at Ay, for the five solutions.

= Calculate the pK, of bromcresol green.

Materials
O Ocean Optics Spectrometer a 0.05 % bromcresol green solution
Q computer 0 1.0 M sodium hydroxide, NaOH, solution
O one cuvette 0 1.0 M hydrochloric acid, HCI, solution
Q one dark cuvette 0 solutions of pH 4, pH 7, and pH 10 buffer
O five test tubes and test tube rack o distilled water
0 10 mL graduated cylinders 0 plastic Beral pipettes
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Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure

PART I: Prepare the sample solutions

1. Label five test tubes #1-5. Transfer 10 mL each of the following solutions to different test tubes:
1.0 M HCl to Test Tube #1, 1.0 M NaOH to Test Tube #2, pH 4 buffer to Test Tube #3, pH 7
buffer to Test Tube #4, and pH 10 buffer to Test Tube #5.

2. Add one drop of 0.05% bromcresol green indicator solution to each test tube. Add a second
drop of indicator only if the colors in the test tubes are very faint and difficult to distinguish
with the naked eye.

PART II: Determine the Anax for HIn and In-

3. The initial absorbance measurements are made with the acid and base solutions, in order to
determine the Amax when the indicator’s equilibrium has been shifted far to the right and far to
the left. Follow the steps below to make these measurements:

a.
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Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite
software.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to
warm up for at least five minutes before proceeding.

Fill a cuvette ~% full with distilled water to serve as a blank.

Place the blank cuvette in the spectrometer. On the left hand side of the toolbar,
manually increase or decrease the integration time so that the peak absorbance is
slightly below 4,000 counts.

Record the absorbance spectrum of the blank (100% transmittance), by clicking the
Store Reference Spectrum icon, «

Remove the blank cuvette and place the dark cuvette in the spectrometer. Save the dark
reference (0% transmittance), by clicking the Store Dark Spectrum icon, ¥.

Remove the dark cuvette from the spectrometer. Empty the distilled water from the
blank cuvette, rinse and fill the cuvette ~%5 full of 1.0 M HCI solution from Test Tube
#1, and place the cuvette in the spectrometer. Identify the wavelength of maximum
absorbance (Amax). Write down the Amax, and the absorbance value, in your data table.
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h. To save this graph, click = . In the Filename box, type in a name for your set of data.
Click [_#=*- _ Type in the name again and click |_3** |, In the Save Spectrum dialog
box, click L3 ] and then click |- . Your file will be saved in the default folder
named “bin”.

i. Empty, rinse and fill the cuvette ~% full of 1.0 M NaOH solution from Test Tube #2,
and place the cuvette in the spectrometer. Identify the wavelength of maximum
absorbance (Amax). Write down the Amax, and the absorbance value, in your data table.
Repeat step h to save the graph of the NaOH absorbance spectrum.

j.  Examine the graph of the Test Tube #1 absorbance spectrum and write down the
absorbance value at the Amax of the Test Tube #2 plot. Do the same examination of the
graph of the Test Tube #2 solution. You will use these values to correct for background
absorbance.

PART III: Determine the Absorbance Values at the Amax for HIn and In-

4, In Part III, you will measure the absorbance spectrum of each of the three buffer solutions
(Test Tubes #3-5) and write down the absorbance of each buffer at the A, you determined for
Test Tube #1 (Hin) and Test Tube #2 (In").

a. Empty, rinse and fill the cuvette ~% full of the pH 4 buffer solution from Test Tube #3,
and place the cuvette in the spectrometer. Click anywhere on the graph to activate the
cursor. Note the green vertical line marking a given wavelength on the graph; a box
below the graph identifies the wavelength. Determine the absorbance value of the pH 4
buffer at the two Amax values you identified in Part II. Write these values down in your
data table.

b. Repeat step 3h to save the graph of the pH 4 buffer absorbance spectrum.

¢. Repeat steps a and b for the buffer solutions in Test Tubes #4 and #5.

5. To prepare individual graphs of your data for printing or inclusion in your lab report:

a. Open the File menu and choose Open — Load Processed Spectrum.

b. The default “bin” folder will appear. Select a file and click ||,

c. Click = (Overlay Spectral Data). In the Load Spectrum dialog box, click on the first
file listed (it will be designated as “Processed”).

d. Click - | Your selected file will be plotted on the graph.

e. (optional) If you wish to plot more than one set of data on the same graph, repeat steps
a-d until you have the desired plots in place.

6. To close the SpectraSuite program, select File — Exit, and then click Lres ]

7. Dispose of the solutions as directed by your instructor.
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Data

PART II: Test Results for HIn and In-

PART III: Test Results for Buffer Solutions

Test Tube

)\max

Absorbance

1 (Hin)

2 (In")

Test Tube

Buffer

Abs at Amax for Hin | Abs at Amax for In-

3

4

4

7

5

10

Data Analysis

1.

18

Prepare two graphs. On the first graph plot the absorbance (Y-axis) as a function of pH (X-axis)
for the five solutions at the HIn Amax value. One the second graph plot the absorbance (Y-axis)
as a function of pH (X-axis) for the five solutions at the In— Amax value.

Calculate the best-fit line equation for each plot and identify the inflection point, which is the

pKa.

Consult your text or other reference for the actual pKa of bromcresol green (it will be
somewhere in the neighborhood of 4.5 — 4.8. Compare your value of the pKa with the actual
value. Suggest reasons why your value is different from the actual value.
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S5 The Ksp of Copper Tartrate

Introduction

The solubility product constant, K, of a slightly soluble salt is an example of aqueous
equilibrium. The K, is defined as the product of the molar concentrations of the ions formed by
the dissociation of the salt, each raised to the power of the coefficient of the balanced reaction
equation. If a species in the equilibrium is colored or forms a colored complex in solution, the K,
may be determined by visible spectroscopy. Copper (II) tartrate dissociates according to the
equation:

CuC,H,04(s) <> Cu”* (aq) + C,H,06™ (aq)

Thus the solubility product constant is described by the expression: Ksp = [Cu2+] [C2H2062-]

You will use an Ocean Optics Spectrometer to first measure the absorbance of a standard copper
(IT) tartrate solution at 676 nm. The copper 2+ ion has a characteristic blue color.

You will prepare five copper (II) sulfate solutions of known concentration (standard solutions)
and measure their absorbance at a selected wavelength. When you graph absorbance vs.
concentration for the standard solutions, a direct relationship will result, which is known as
Beer’s law.

Finally, you will measure the absorbance of a saturated copper (II) tartrate solution and use the
Beer’s law information from the standard samples to calculate the Ksp of copper (II) tartrate.

Objectives

In this experiment, you will

= Measure and analyze the visible light absorbance spectrum of a standard Cu®" solution to
determine the maximum wavelength of absorbance.

= Prepare and test the absorbance of five standard Cu®" solutions.
= (Calculate a standard curve from the test results of the standard solutions.

=  Use the standard curve to determine the K, of copper (II) tartrate.
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Materials
@ Ocean Optics Spectrometer a 0.100 M copper (II) sulfate, CuSOy, solution
Q computer a 0.100 M sodium tartrate, Na,C,H,0¢ , solution
Q pipette pump or pipette bulb o distilled water
a 1 cuvette a filter and filter funnel
0 Two 50 mL Erlenmeyer flasks O quantitative filter paper
O Two 10 mL pipettes or graduated O tissues (preferably lint-free)
cylinders
a Two 100 mL volumetric flasks o centrifuge and centrifuge tubes
O S test tubes and test tube rack O Three 10 mL graduated pipettes

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure

PART I Preparing a Saturated Solution of Copper (II) Tartrate

1. Prepare a saturated solution of copper (II) tartrate by mixing: 4 mL of 0.100 M copper (1)
sulfate solution, 5 mL of 0.100 M sodium tartrate solution, and 1 mL of distilled water in a 50
mL Erlenmeyer flask. Mix thoroughly. Note that a precipitate forms. Allow the mixture to
remain undisturbed for 15 minutes.

2. Centrifuge the liquid and keep the clear liquid layer. If the liquid layer appears slightly cloudy,
centrifuge it a second time or filter the liquid through quantitative filter paper.

PART II Preparing Standard Solutions of Copper (II) Tartrate

3. Label five clean, dry, test tubes 1-5. Use pipettes to prepare five standard solutions according to
the chart below. Thoroughly mix each solution with a stirring rod. Clean and dry the stirring rod

between uses.

Test Tube 0.100 M CuSOs« | 0.100 M Distilled H20 (mL) | CuC2H:0¢

number (mL) Na;C:H:06 (ML) Concentration (M)
1 2.00 5.00 3.00 0.020

2 1.80 5.00 3.20 0.018

3 1.50 5.00 3.50 0.015

4 1.20 5.00 3.80 0.012

5 1.00 5.00 4.00 0.010
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4. Dilute 5 mL of 0.100 M NaC2H206 with 10 mL of distilled water. Fill an empty cuvette ¥ full
with this dilute Na2C2H206 solution.

5. Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

6. Calibrate the spectrometer.

a.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to
warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New —
Absorbance Measurement. The “Set Acquisition Parameters wizard” will appear. This
process has four steps. First, confirm that your spectrometer has been identified, and
then click > |

In step two of this process, make sure that the box next to “Strobe/Lamp Enable” is
checked. Manually select a suitable integration time by using the arrow keys to increase
or decrease the integration time, in milliseconds. Click Met> | proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the Store
Reference Spectrum icon, « . Click _et> |t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save the
dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.

Pour out the distilled water from the blank cuvette, rinse, and fill it with the CuC2H206
solution in Test Tube #1. Place the cuvette in the spectrometer. Click L 1 to
complete the acquisition parameters wizard.

A plot of absorbance vs. wavelength for your CuC2H206 solution is displayed.
Examine the graph and select the peak wavelength that you wish to use for your Beer’s
law experiment.

7. Collect absorbance-concentration data for the five standard CuC,H,04 solutions.

a.

Open the File menu and choose New — New Concentration Measurement. Select

“Active Processing:”, and then click %< _J.

The Concentration Measurement Setup wizard appears, and its default is the Beer-
Lambert Law. Select “Calibrate from solutions of known concentration”. Click "> _|.

The Range Selection defaults to a single wavelength. Enter the peak wavelength that
you identified in Step 6g, and then click Mest> |

The next dialog box sets up the Beer’s law graph of your standard solutions. Type in
the molar concentration of your first sample, 0.020. Click L2t %#_| and then click

graph in the dialog box.

Remove the cuvette and dispose of the solution as directed. Rinse and fill the cuvette
with the CuC2H206 standard solution in Test Tube #2. Place the cuvette in the
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f.  Repeat step e for the remaining standards. When you complete the final standard
solution, type in the compound name and unit of concentration (mol/L). A best-fit line
is calculated for your standards. Make sure the regression order is set to 1. Note: To

delete a data point, choose a row of data and click . Click L=t ] 1o

continue.

8. Write down the absorbance values for the standard solutions, as well as the best-fit line equation
for the standards.

9. To measure the absorbance of the saturated CuC2H206 solution, rinse and fill the cuvette ~%
full with the saturated CuC2H206 solution you prepared in Part I. Click Single Update and write

down the concentration.

10. To close the SpectraSuite program, select File — Exit, and then click Lres ]

Data

Test Tube Concentration (mol/L) Absorbance
1 0.020
2 0.018
3 0.015
4 0.012
5 0.010

Best-fit line equation:

Data Analysis

1. Determine the concentration of the saturated CuC2H206 solution.

2. Use your test results to calculate the Ksp for CuC2H206. Compare your empirical Ksp with the
published (Lange’s Handbook of Chemistry) value of 4 x 10-4.
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6 Spectrophotometric Analysis of a
Buffer Solution

Introduction

Determination of pH is one of the most frequently performed measurements in chemistry. The
potentiometric method with a glass electrode has been widely used for pH measurements but has
drawbacks such as the need for a reference electrode, susceptibility to electrical interference and
instrument drift. It is desirable to have alternative methods for pH determination. One such
method is spectrophotometric measurement with the use of a pH indicator. In a
spectrophotometric method, the pH of an unknown solution is determined by addition of a pH
indicator and subsequent measurement of absorbance of the resulting solution. Because overlap
exists between the spectra for the acid form (Hln) and base form (In-) of the indicator, it is
necessary to determine individual molar absorptivities for each form at two wavelengths (A1 and
A2), usually these are the wavelength peaks or absorption maxima of Hln and In-.

In this experiment, you will use an Ocean Optics spectrometer to determine the pH of an acetate
buffer solution. You will measure the absorbance spectrum, over the 380 — 950 nm range, of the
indicator bromcresol green when it is added to the acetate buffer that is subsequently treated with
a basic solution and an acidic solution.

Objectives

In this experiment, you will

=  Measure and analyze the visible light absorbance spectrum of an acetate buffer solution,
containing bromcresol green indicator.

= Compare the spectra of a sample of acetate buffer that has been treated with acid to a
sample of the buffer treated with base.

= Use your test results to calculate the pH of the buffer solution.

Materials
O Ocean Optics spectrometer Q solid sodium acetate, NaCH;COO
O computer 0 1x10™* M bromcresol green solution
a 1 cuvette a 0.10 M hydrochloric acid, HCI, solution
O S5 mL and 10 mL pipette and pump 0 0.10 M sodium hydroxide, NaOH, solution
0 100 mL volumetric flask a 2.40 M acetic acid, CH;COOH, solution
0 four 50 mL volumetric flasks a distilled water
O 25 mL graduated cylinder
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Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure

PART I: Prepare the acetate buffer solution

1.

Pipette 5.00 mL of 2.40 M acetic acid, CH3COOH, solution into a 100 mL volumetric flask.
Dilute with about 50 mL of distilled water.

Measure out 0.825 g of sodium acetate, NaCH3COO, and quantitatively transfer it to the
volumetric flask. Swirl the flask until the solid completely dissolves.

Add distilled water to the volumetric flask to make 100 mL of buffer solution.

PART II: Prepare the sample solutions

4.

Pipette 10.00 mL of 1x10—4 M bromcresol green solution to each of three 50 mL volumetric
flasks. Label the flasks A-C. In flask A, use a graduated cylinder to add 25 mL of 0.10 M HCl
solution. In flask B, add 25 mL of 0.10 M NaOH solution. In flask C, add 25 mL of the acetate
buffer solution you prepared in Part 1.

Add distilled water to each volumetric flask to make 50 mL of solution.

PART III: Test the sample solutions

6.

7.
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Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to warm
up for at least five minutes before proceeding.

Fill a cuvette ~%; full with distilled water to serve as a blank.
Calibrate the spectrometer and measure the absorbance of the three flasks of solutions.

a. Place the blank cuvette in the spectrometer. Open the File menu and choose New —
Absorbance Measurement. The “Set Acquisition Parameters wizard” will appear. This
process has four steps. First, confirm that your spectrometer has been identified, and
then click _> |

b. In step two of this process, make sure that the box next to “Strobe/Lamp Enable” is
checked. Manually select a suitable integration time by using the arrow keys to increase

or decrease the integration time, in milliseconds. Click _Met> g0 proceed.

c. To record the absorbance spectrum of the blank (100% transmittance), click the Store
Reference Spectrum icon, « . Click _Met> |1 proceed.
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d. Remove the blank cuvette and place the dark cuvette in the spectrometer. To save the

dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.

Pour out the distilled water from the blank cuvette, rinse, and fill it with the mixture in
Flask A. Place the cuvette in the spectrometer. Click L_f5"_| to complete the
acquisition parameters wizard.

A plot of absorbance vs. wavelength for the sample in Flask A is displayed. Identify the
wavelength of greatest absorbance (A max) and write it down in your data table. If there
is a secondary absorbance peak, record it in your data table.

10. To save the plot of the mixture in Flask A, follow these steps.

a. In the toolbar across the top of the graph, click = to save the absorbance spectrum.

b.

C.

In the Filename box, type in a name for your set of data.

Click [_#=#=- _ Type in the name again and click [ 5= |,

d. Inthe Save Spectrum dialog box, click |5 | and then click _2=_|. Your file will be

saved in the default folder named “bin”.

11. Pour out the Flask A from the cuvette, rinse, and fill it ~% full with the mixture in Flask B.
Place the cuvette in the spectrometer. Note that the absorbance plot for the sample is displayed.
Identify and record the A max and a secondary absorbance peak. Repeat Step 10 to save the plot.

12. Measure the absorbance of the mixture in Flask C, as you did with the other two samples, with
one important change. The absorbance peaks of the buffer solution may be slightly different
from the peaks of the acidic and basic solutions. Even so, you must record the absorbance
values at the same two wavelengths as the acidic and basic solutions.

13. Dispose of the solutions as directed by your instructor.

14. To prepare a graph of any of the three plots, follow these steps:

a.

b.

d.

Open the File menu and choose Open — Load Processed Spectrum.

The default “bin” folder will appear. Select a file and click |_“**_|. This will open the
file, but not display the data on the graph yet.

Click = (Overlay Spectral Data). In the Load Spectrum dialog box, click on the first
file listed (it will be designated as “Processed”).

Click 2% | Your selected file will be plotted on the graph.

Repeat Steps a-d until you have the desired plots on your graph.
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Data Table

Flask | Solution 1st Peak/absorbance | 2" Peak/absorbance
A Indicator w/ Acid
B Indicator w/ Base
C Indicator w/ Buffer
Data Analysis

1. Calculate the molar absorptivity of HIn and In™ at each wavelength peak, identified in your data
table, for each sample.

2. Calculate the [HIn] and [In—] of the acetate buffer solution.

3. Calculate the [H+] and the pH of the buffer solution, using the Ka for bromcresol green:
1.60 x 10-5.

4. Another way to calculate the pH of the acetate buffer is to use the Henderson-Hasselbalch
equation. Find this equation in your text and use it to calculate the pH of the buffer.

7  The Beer’s Law Analysis of
Erythrosin B

Introduction

There are a number of solutions and compounds that are excellent candidates for
spectrophotometric analysis, but are toxic or expensive or difficult to handle. Two shining
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examples are chromate and dichromate ions. The sodium or potassium salts of these ions are
readily soluble in water, are relatively high molecular mass, and both ions are vividly colored in
solution, making them the perfect candidates for conducting colorimetric analyses. If it were not
for their severe toxicity, the title of this experiment most assuredly would include either
“chromate” or “dichromate”.

One of the important skills one practiced when conducting a colorimetric experiment with a
chromate or dichromate compound was preparing solutions of very low molar concentration. A
sodium dichromate solution of 5.00 x 10~ M absorbs sufficiently strongly to conduct an accurate
and precise Beer’s Law experiment. Thus, the purpose of this experiment is twofold: (1) to
prepare standard solutions of low molar concentrations; (2) to conduct a Beer’s Law analysis of
the standards and measure their effectiveness in determining the molar concentration of a solution
of unknown concentration.

To replace a chromate or dichromate compound, one must identify a substance possessing low
toxicity, high molecular mass, high water solubility, and bright color in aqueous solution. The
choice in this experiment will be Erythrosin B, which is an FDA-approved (low toxicity) food
dye (bright color, water soluble) with a molecular mass of 879.87 g/mol and a wavelength of
maximum absorbance in the visible light range. Among other uses, Erythrosin B is used to color
maraschino cherries. In fact, one of the objectives of the experiment will be to determine the
amount of Erythrosin B found in a bottle of commercially available maraschino cherries.

Objectives

The objectives of this experiment are:

= Measure the absorbance spectrum of an Erythrosin B solution to determine the
wavelength of maximum absorbance, Amax.

= Measure the absorbance of a set of Erythrosin B standard solutions at Amax.

=  Determine the concentration of Erythrosin B in a container of maraschino cherries.
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Materials

O

Ocean Optics Spectrometer
computer

several cuvettes

1 dark cuvette

6 test tubes and test tube rack
volumetric pipettes

0 100 mL volumetric flask

Erythrosin B

distilled water

container of maraschino cherries
small beakers

plastic Beral pipettes

balance, 0.001 g accuracy
glassware as needed

OO0 0DD
[y Ry Sy Sy

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Pre-Lab Calculation
Calculate the mass of Erythrosin B needed to prepare 100 mL of 1.00 x 10~ M solution.

Procedure

1.
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Prepare 100 mL of 1.00 x 10-3 M Erythrosin B solution. Use this solution as your stock
solution. You will need to dilute this solution significantly to prepare the standard solutions,
thus plan the most efficient method of preparing your standards and obtain the necessary
concentrations.

Label five test tubes to use for your standard solutions. Use volumetric pipettes to measure your
liquids. Complete the mixing chart based on you plans to use your stock Erythrosin B solution.

Test Tube [Erythorsin B] mL of dilute Erythrosin B | mL of distilled water
(mollL)

1 5.00 x 107°

4.00x 10°°

3.00 x 107°

2.00 x 107°

o |~ W DN

1.00 x 107°

Obtain a small amount of the liquid from a container of maraschino cherries to serve as your
unknown. Prepare a set of serial dilutions of this liquid so that you have one sample with a
suitable absorbance for analysis.

Fill a cuvette ~%; full with distilled water to serve as your blank.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.
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6. Calibrate the spectrometer.

a.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to
warm up for at least five minutes before proceeding.

Place the blank cuvette in the spectrometer. Open the File menu and choose New —
Absorbance Measurement. The “Set Acquisition Parameters wizard” will appear. This
process has four steps. First, confirm that your spectrometer has been identified, and
then click _> |

In step two of this process, make sure that the box next to “Strobe/Lamp Enable” is
checked. Manually select a suitable integration time by using the arrow keys to increase
or decrease the integration time, in milliseconds. Click Met> | proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the Store
Reference Spectrum icon, - . Click tet> [t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save the
dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.

Pour out the distilled water from the blank cuvette, rinse, and fill it with the 5.00 x 10-6
M Erythrosin B solution in Test Tube #1. Place the cuvette in the spectrometer. Click
L_fesh | to complete the acquisition parameters wizard.

A plot of absorbance vs. wavelength for your Erythrosin B solution is displayed.
Examine the graph and select the peak wavelength that you wish to use for your Beer’s
law experiment.

7. Setup the Beer’s Law experiment.

a.

Open the File menu and choose New — New Concentration Measurement. Select

“Active Processing:”, and then click %< _J,

The Concentration Measurement Setup wizard appears, and its default is the Beer-
Lambert Law. Select “Calibrate from solutions of known concentration”. Click "> _|.

The Range Selection defaults to a single wavelength. Enter the peak wavelength that
you identified in Step 6, and then click Neat> |

The next dialog box sets up the Beer’s law graph of your standard solutions. Type in
the molar concentration of your first sample, 0.000005. Click |_#2'#5# | and then
click _##ssw | The absorbance of your first standard is saved and plotted on the small
graph in the dialog box.

Remove the cuvette and dispose of the solution as directed. Rinse and fill the cuvette
with the Erythrosin B standard solution in Test Tube #2. Place the cuvette in the

spectrometer. Type in the molar concentration, click [ ootz | and then click

Ak Samgle |

© 2007 Ocean Optics, Inc 29



Applications in Spectroscopy

f.  Repeat Step e for the remaining standards. When you complete the final standard
solution, type in the compound name and unit of concentration (mol/L). A best-fit line
is calculated for your standards. Make sure the regression order is set to 1. Note: To

delete a data point, choose a row of data and click ' Click /st 1o

continue.

8.  Write down the absorbance values and the best-fit line equation for your standard solutions in
your data table.

9. Compare the serial dilutions of your unknown to your standard solution. Choose one of the
dilute solutions to test. Rinse and fill the cuvette ~% full with the unknown sample. Click Single
Update. If the dilute solution has an absorbance that falls within the range of absorbance values
you recorded for your standard solutions, write down the concentration in your data table.

10. Choose one or two other dilute solutions of your unknown to test in this way. The more
measurements of absorbance and concentration for your unknown, the more accurate and
precise your final determinations will be.

11. To close the SpectraSuite program, select File — Exit, and then click Cores ],

Data Table

Test Tube Concentration (mol/L) Absorbance

1

Unknown #1

Unknown #2

Unknown #3

Best-Fit Line Equation:

Data Analysis

1. At which wavelength did you measure the absorbance of the Erythrosin B standard solutions?
Was there another wavelength that you also could have used?
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2. What was the concentration of the Erythrosin B in the container of maraschino cherries?

3. If Erythrosin B had been mixed with another food dye in the container of cherries, explain how
you would analyze the liquid to determine the concentration of Erythrosin B.
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8 Spectrophotometric Characterization
of Spice Extracts

Introduction

Spices have a long a rich history around the world. In some senses (pun intended, although
sorrowfully) the cuisine of a particular region identifies itself with specific local spices. Used to
modify, in a positive fashion, the flavor of prepared foods, help preserve foods for later
consumption, and act as herbal remedies for a wide variety of real and imagined ills, it is difficult
to imagine a world without spices. Varieties of spices must indeed be the spice of life.

Along with the important role of contributing to the flavors of foods, spices are also employed to
modify the color of foods. Turmeric adds a strong yellow tinge to curries and saffron offers a
softer yellow to paellas. Paprika contributes a deep, vibrant red to chicken paprikash as well as
presenting a vivid, flavorful spice garnish to simple cottage cheese. It is this property of spices,
color, which you will investigate in this experiment.

You will use isopropanol, also known as rubbing alcohol, to prepare extracts of a selection of
spices. You will then use an Ocean Optics spectrometer to measure the visible light absorbance
spectrum of the spice extracts. And finally, you will test a few food products to determine
whether or not a spice is present.

Objectives
In this experiment, you will

=  Measure and analyze the visible light absorbance spectra of several spice extracts.
= Measure the visible light absorbance spectra of selected prepared foods.

=  Analyze your data to identify the presence of specific spices added to the foods.

Materials
O Ocean Optics Spectrometer O Plastic Beral pipettes
Q computer Q spices, such as: paprika, turmeric, saffron, parsley,
jalapeno, cumin, curry
O several cuvettes a 70% rubbing alcohol
O one dark cuvette O unknown spice extract, prepared in
0 25 mL graduated cylinders a  70% rubbing alcohol

O several 50 mL beakers

Safety

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.
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Procedure

1.

Place a very small amount of each spice in a 50 mL beaker. Add 20 mL of rubbing alcohol
(70% isopropanol). Swirl each beaker to mix the spices. Allow the mixtures to sit for 30 minutes
so the colorants are well dissolved and any particulate matter settles to the bottom of the

beakers.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to warm
up for at least five minutes before proceeding.

Fill a cuvette ~%; full with 70% rubbing alcohol to serve as a blank.

Calibrate the spectrometer and measure the absorbance of the spice extracts.

a.

Open the File menu and choose New — Absorbance Measurement. The “Set
Acquisition Parameters wizard” will appear. This process has four steps. First, confirm
that your spectrometer has been identified, and then click | Met> |

Place the blank cuvette in the spectrometer. In step two of this process, make sure that
the box next to “Strobe/Lamp Enable” is checked. Manually select a suitable
integration time by using the arrow keys to increase or decrease the integration time, in
milliseconds. Click _**> | to proceed.

To record the absorbance spectrum of the blank (100% transmittance), click the Store
Reference Spectrum icon, « . Click _et> |t proceed.

Remove the blank cuvette and place the dark cuvette in the spectrometer. To save the
dark reference (0% transmittance), click the Store Dark Spectrum icon, ¥.

Pour out the rubbing alcohol from the blank cuvette, rinse, and fill it ~7; full with the
one of the spice extracts. Place the cuvette in the spectrometer. Click L5 I to
complete the acquisition parameters wizard. A plot of absorbance vs. wavelength for the
extract is displayed

6. To save the plot of your first spice extract, follow these steps:

a.

b.

Click = to save the absorbance spectrum.
In the Filename box, type in a name for your set of data.
Click &= Type in the name again and click | 5= _J.

In the Save Spectrum dialog box, click |3 | and then click -2 _. Your file will be
saved in the default folder named “bin”.

7. Pour out the extract from the cuvette, rinse, and fill it ~%4 full with another spice extract. Place
the cuvette in the spectrometer. Note that the absorbance plot for the yellow solution is
displayed. Repeat Step 6 to save the plot.
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8. Repeat Step 7 with your remaining spice extracts.

9. Obtain an unknown spice extract mixture. Repeat Step 7 to measure its absorbance spectrum.

10. Before you exit the SpectraSuite program, print copies of the absorbance spectrum graphs for
each of your spice extracts and your unknown spice mixture. Alternately, keep SpectraSuite
running and use it to analyze your graphs.
To prepare a graph of any of the extracts, follow these steps:

a. Open the File menu and choose Open — Load Processed Spectrum.

b. The default “bin” folder will appear. Select a file and click || This will open the
file, but not display the data on the graph yet.

c. Click & (Overlay Spectral Data). In the Load Spectrum dialog box, click on the first
file listed (it will be designated as “Processed”).

d. Click % | Your selected file will be plotted on the graph.

e. Repeat Steps a-d until you have the desired plots on your graph.

Data and Analysis

1. Print a copy of the absorbance spectrum for each of the spice extracts that you tested, as well as
the unknown spice mixture. Note the distinguishing characteristics of the spectra that will help
you identify the unknown.

2. Which spice, or spices, is contained in your unknown? Explain.

3. Ifdistilled water had been used as the calibration blank for the chlorophyll test, would it have
affected the absorbance measurements?
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9 Determining the Manganese
Concentration in a Steel Sample

Introduction

Steel is mostly iron, of course, but it can contain a variety of metal additives to modify its
ductility, tensile strength, and other properties depending on the function the steel is to perform.
One of the metals found in steel is manganese, which contributes to its tensile strength. However,
the amount of manganese in steel is normally very small, less that 1% of the total mass of the
steel. Thus, it is not easy to measure the amount in manganese in steel. One method does provide
a suitable determination of the manganese concentration in steel, and that is a spectrophotometric
analysis.

The method follows several steps in order to convert the manganese from its elemental form to an
ion possessing a color that can be measured by a spectrometer. The first step is to dissolve a
sample of steel in nitric acid, which oxidizes the Mn to Mn*" ions, as shown in the reaction
equation below:

3Mn+2NO; +8H < 3Mn" +2NO+4H0
The product mixture is boiled and ammonium peroxydisulfate (also known as ammonium
persulfate), (NHy), S,Os is added to remove the NO, a species that will interfere with the rest of
the process. The reaction to cleanse the mixture of NO is:

2NO +3 $,05 +4 H,0 <> 2NO; + 6 SO, + 8 H”
Unfortunately, when we knock out the NO we also disturb the Mn*" ions. Thus, the next step
involves adding sodium bisulfite, NaHSO3, to reduce any manganese that was converted to MnO,
by the ammonium peroxydisulfate. During the experiment, you will note the formation of MnO,
as a brownish precipitate. It is hoped that a bare minimum of this precipitate forms. This step is
done simply to prep the manganese for its final conversion to permanganate ion, MnO, ", and will
not be shown here.

The final step, before you analyze the sample with an Ocean Optics spectrometer, is to oxidize
the Mn”" to MnO,~ by adding potassium metaperiodate, KIO,, as shown below:

2Mn* +510, +3H,0 < 2MnO; +5105 +6 H

Now the manganese is locked into an ion, MnQOy, that is a purplish color. By measuring the
absorbance of several standard solutions of MnO4 with known concentrations you will be able to
determine the amount of manganese in your sample of steel.

Objectives

The objectives of this experiment are:

=  Chemically isolate the manganese in a sample of steel as MnO,".
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= Measure the absorbance spectrum of a standard MnO, solution to determine the

wavelength of maximum absorbance, Apax.

= Measure the absorbance of several standard samples of MnO,~ solution to establish a

Beer’s Law plot.

= Use the Beer’s Law plot of the MnO, standards to determine the concentration of

manganese in a steel sample.

Materials
a
Q computer
a
Q one cuvette
a
a
a
a
a
0 ice bath
a

Safety

Ocean Optics Spectrometer
pipette pump or pippette bulb

four 125 mL Erlenmeyer flasks
50 mL graduated cylinder
two 100 mL volumetric flasks

two 50 mL volumetric flasks
funnel and quantitative filter paper

test tubes and test tube rack

ooopo00O0o0oDODO

two steel samples, ~0.8 g each

6 M HNO:; solution

ammonium peroxydisulfate, (NHy), S,0s
sodium bisulfite, NaHSO;

potassium metaperiodate, KIO,

2.00 x 10™* M KMnOj solution
concentrated phosphoric acid, H;PO,
distilled water

fume hood

balance, 0.001 g accuracy

hot plate

Wear safety goggles and other appropriate safety gear (gloves or apron) during the experiment.
Take all proper safety precautions when handling the solutions.

Procedure

PART I Prepare and Test Standard Solutions of Potassium Permanganate

1. Prepare five standard solutions of potassium permanganate, KMnO,, solution following the
mixing chart below. Measure the volumes with pipettes and label five test tubes in which to

store your standards.

Test Tube [KMnOg] mL of 2.00 x 104 M mL of distilled water
(mollL) KMnO, (aq)

1 2.00x10™* | 10.00 0.00

2 1.60x10* | 8.00 2.00

3 1.20x 10" | 6.00 4.00

4 8.00 x 10° | 4.00 6.00

5 4.00x10° | 2.00 8.00
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PART II Chemically Convert the Mn in a Steel Sample to MnO4-

2.

Measure the mass of two steel samples, to the nearest 0.001 g. Write down the mass of each
sample in your data table. Transfer each sample to its own 125 mL Erlenmeyer flask and place
the flasks on a hot plate in a fume hood.

Transfer 40 mL of 6 M HNO3 solution to each flask containing the steel samples. Heat the
flasks to a gentle boil for about 5 minutes, and then cool the flasks to room temperature. Use an
ice bath, if desired, to cool the samples more quickly.

Slowly and carefully add 0.1 g of ammonium peroxydisulfate to each flask and gently boil the
reaction mixtures for 5 more minutes, followed by cooling to room temperature.

Add 0.1 g of sodium bisulfite to each flask, boil the mixtures for 5 minutes, and cool them to
room temperature. If the solutions are clear, then quantitatively transfer each solution to its own
100 mL volumetric flask and fill the flask to the line with distilled water. If the solutions are not
clear, filter each solution through quantitative filter paper to collect the residue and then
quantitatively transfer the solutions to 100 mL volumetric flasks. Stopper the flasks and invert
them a few times to mix the solution.

Use a pipette to transfer a 25.00 mL aliquot of solution from each of the volumetric flasks to
two 125 mL Erlenmeyer flasks. Add 4 mL of concentrated H3PO4 to each 25 mL aliquot. Add
0.4 g of potassium metaperiodate, KIO4 and gently boil the flasks for 2 minutes. Cool the flasks
of mixtures to room temperature.

Quantitatively transfer the aliquots to separate 50 mL volumetric flasks. These samples are now
ready to be tested. Stopper the flasks and set them aside until Part IV of the experiment.

PART III Measure the Absorbance of the Standard MnO4- Samples

8.

9.

Fill a cuvette ~% full with distilled water to serve as your blank.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

10. Calibrate the spectrometer.

a. On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer
to warm up for at least five minutes before proceeding.

b. Place the blank cuvette in the spectrometer. On the left hand side of the toolbar,
manually increase or decrease the integration time so that the peak absorbance is
slightly below 4,000 counts.

¢. Record the absorbance spectrum of the blank (100% transmittance), by clicking the
Store Reference Spectrum icon, «.

d. Remove the blank cuvette and place the dark cuvette in the spectrometer. Save the dark
reference (0% transmittance), by clicking the Store Dark Spectrum icon, ¥.
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c.

Remove the dark cuvette from the spectrometer. Empty the distilled water from the
blank cuvette, rinse and fill the cuvette ~%4 full of the KMnQj, solution from Test Tube
#5, and place the cuvette in the spectrometer. Identify the wavelength of maximum
absorbance (Ay,y). Write down the A,,,,,, and the absorbance value, in your data table.

11. Measure the absorbance of the standard KMnO;, solutions.

a.

Open the File menu and choose New — New Concentration Measurement. Select

“Active Processing:”, and then click [_fcest |

The Concentration Measurement Setup wizard appears, and its default is the Beer-
Lambert Law. Select “Calibrate from solutions of known concentration”. Click "> |

The Range Selection defaults to a single wavelength. Enter the peak wavelength that
you identified in Step 6, and then click et > |

Type in the molar concentration of Test Tube #1 solution, 0.0002. Click [Lsetastscmn |
and then click _#¥%m* | The absorbance of your first standard is saved and plotted on
the small graph in the dialog box.

Remove the cuvette and dispose of the solution as directed. Rinse and fill the cuvette
with the KMnO#4 standard solution in Test Tube #2. Place the cuvette in the

spectrometer. Type in the molar concentration, click | etest s | and then click
Add Sampls |

Repeat Step e for the remaining standards. When you complete the final standard
solution (2.00 x 10-3 M), type in the compound name and unit of concentration
(mol/L). A best-fit line is calculated for your standards. Make sure the regression order
is set to 1. Note: To delete a data point, choose a row of data and click .
Click L_f="_| to continue.

PART IV Measure the Absorbance of the Treated Steel Samples

12.

13.

14.

15.

Data

Choose one of the two samples, stored in a 50 mL volumetric flask, to test. Using the same
cuvette with which you measured the standard solutions, rinse and fill the cuvette ~%; full with
the liquid from the volumetric flask. Click Single Update and write down the concentration of
the first aliquot of treated steel.

Repeat Step 12 with the second sample in the 50 mL volumetric flask.

(optional) Upon the direction of your instructor, repeat Step 6 and 7 in Part II to prepare
additional samples of the treated steel and test them as you did the first two samples.

To close the SpectraSuite program, select File — Exit, and then click (e ],

PART III Standard MnO4- Samples

38
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Wavelength of maximum absorbance (An.x) =_ nm

Test Tube Concentration(mol/L) Absorbance

1

PART IV Treated Steel Samples
Steel Sample Mass Abs at Amax [MnO«]

1

2

Data Analysis

1. Calculate the mass of manganese in the treated steel samples.

2. Calculate the concentration of manganese in the steel samples. Express your answer in mass of
manganese per gram of steel.

3. Describe the sources of error inherent in this process of determining Mn in steel.

4. In Step 6 (Part II), concentrated phosphoric acid was added to the final treated samples so that
any iron that found its way through the process would be rendered clear to the spectrometer.
However, in some types of steel chromium and/or cerium are present. These two elements
interfere in a very problematic manner because their absorbance maxima are very close to that
of the MnO4— ion. Suggest a method for dealing with steel samples that contain Cr and Ce,
when your goal is to determine the Mn concentration.
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10 Investigating the Absorbance
Spectra of Iodine

Introduction

A spectrometer is normally employed to measure the absorbance or % transmittance of a liquid
sample bearing a color or absorbing light in the ultraviolet range outside the range of human eyes.
In addition, an Ocean Optics spectrometer can measure light that is emitted from a source such as
a discharge tube, light that is reflected off a solid surface, or light that resulted from fluorescing
or luminescing materials. It can also measure gases, although other devices are more commonly
used in these instances.

Say, for instance, that a very small amount of a solid was placed in a standard cuvette and the
cuvette was sealed. If the solid sublimed at room temperature, and if the gas produced by the
sublimation was also colored, then perhaps a spectrometer could measure the absorbance of the
gas molecules. There is such a solid substance, iodine (12). And, as it so happens, quite a lot can
be learned by the simple measurement of the graph of data that appears when the visible light
absorbance spectrum of iodine is analyzed.

The absorbance spectrum of gaseous iodine presents a set of data unlike that of a liquid sample,
which is not a huge surprise, but is quite similar to that of emissions from a gas discharge tube.
This makes perfect sense when you consider that the light source in the spectrometer is an
excitation source for the gas molecules. An absorbance spectrum of iodine in solution can be
easily achieved, as iodine is soluble in a variety of common solvents, including: ethanol, diethyl
ether, chloroform, and glycerol.

Objectives
The objectives of this experiment are:
= Measure the visible light absorbance spectrum of gaseous iodine, I,.

= Measure the visible light absorbance spectrum of iodine dissolved in ethanol.

= Compare and contrast the iodine spectra.

Materials
O Ocean Optics Spectrometer o dark cuvette
O computer O sealed glass cuvette of iodine vapor
O empty glass cuvette O sealed glass cuvette of solution of iodine in

ethanol

Safety

Do not open the sealed cuvettes. The vapors are harmful, and many people are allergic to iodine.
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Procedure

1.

Obtain an empty glass cuvette and two sealed glass cuvettes: one containing iodine vapor and
the other containing iodine dissolved in ethanol. There may be a tiny nugget of solid iodine in
the bottom of one cuvette; this will not affect your absorbance spectrum readings.

Use a USB cable to connect a spectrometer to your computer. Start the SpectraSuite software.

On the toolbar, check the box next to “Strobe/Lamp Enable”. Allow the spectrometer to warm
up for at least five minutes before proceeding.

After the spectrometer has warmed up, place the empty glass cuvette in the spectrometer. On the
left hand side of the toolbar, manually increase or decrease the integration time so that the peak
absorbance is slightly below 4,000 counts.

Record the absorbance spectrum of the blank (100% transmittance), by clicking the Store
Reference Spectrum icon, =« .

Remove the empty glass cuvette and place the dark cuvette in the spectrometer. Save the dark
reference (0% transmittance), by clicking the Store Dark Spectrum icon, ¥.

Remove the dark cuvette from the spectrometer. Place the cuvette of iodine vapor in the
spectrometer.

Follow the steps below to save the graph of the iodine vapor absorbance:

a. Click = to save the absorbance spectrum.
b. In the Filename box, type in a name for your graph.
c. Click l_#=*=- _ Type in the name again and click [ 5= |,

d. Inthe Save Spectrum dialog box, click |5 | and then click _2=_|. Your file will be
saved in the default folder named “bin”.

Remove the iodine vapor cuvette from the spectrometer. Place the cuvette of iodine-in-ethanol
solution in the spectrometer.

10. Repeat Step 8 to save the graph of the iodine solution absorbance.

11. To close the SpectraSuite program, select File — Exit, and then click [res ],
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Data Analysis

1. Print a copy of each of your two absorbance vs. wavelength graphs.

2. Examine the graph of absorbance vs. wavelength for iodine vapor. Speculate about the unusual
plot of absorbance for the vapor.

3. Noting that the light source of the spectrometer can present excitation energy for the vapor,
make a case for the plot of gaseous iodine representing quantum movement.

4. Describe the absorbance spectrum of the iodine solution. Do any of the absorbance peaks relate
to the graph of iodine vapor? Explain.

Extension

The measure the absorbance of gaseous iodine is described in an excellent article published in the
Journal of Chemical Education in 1987 — volume 64, number 11 (November), pages 919 — 921.
Secure a copy of this article, and use your data from the absorbance spectrum of gaseous iodine to
complete the following calculations:

(a) the fundamental oscillating frequency (®)

(b) the force constant of the I — I bond (k)

(c) the anharmonicity constant (x)

(d) the dissociation energy (Do)
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